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Autodesk Navisworks does not coordinate construction projects, people do. This class will help attendees
understand how Navisworks and BIM 360 Glue can be used as tools to effectively manage teams and
review projects. Template setup, effective clash detective use, coordination reporting, meeting prep,
follow-up actions and methods for trending coordination will be covered amongst many other tips and
tricks to keep the team engaged in the process.

Learning Objectives
At the end of this class, you will be able to:

e Understand how to set up clash tests and rules
e Discover effective clash grouping and filtering techniques
e Discover effective model-review meeting management

e Discover tips and tricks for effective project management

About the Speaker

Michael Boyd works within the WSP UK Project Technology Team, a group set up to provide the
Information Manager and Building Information Modeling (BIM) coordination role on construction projects.
He also has an internally focused role and is responsible for the implementation and management of
BIM within WSP UK. Software implementation, team mentoring on live projects, and staff training are
key parts of his role, and he leads BIM teams on some of the largest projects in the United Kingdom. A
long-time user of Autodesk, Inc. products, Michael is a beta tester and Gunslinger for the Revit software
platform. Michael is also the co-founder of the Edinburgh Revit User Group, and he is a frequent speaker
at other user groups and BIM-related conferences in the United Kingdom and abroad.

Michael.Boyd@WSPGroup.com

@_michaelboyd

uk.linkedin.com/in/michaelwboyd/
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1. Introduction

This handout and associated presentation is aimed at beginners, or users who have used Navisworks but
are struggling to get to grips with its features. If you have used Navisworks in anger for over six months
then you likely know most of its contents but | sincerely hope you might pick up one or two tips that help
you in your projects.

Enjoy and please feel free to get in touch.

Michael

1.1 What is Navisworks?

Navisworks is project review software that provides the opportunity to federate and analyse models,
improving the coordination and communication of a design. It is mainly used to analyse models for
construction planning, logistic planning and cost surety. It can link the 3D Geometric models with
databases, providing a starting point for asset management.

It is not a model authoring tool.

1.2 Navisworks Product Line
Navisworks is available in three different versions:

e Manage (Fully Functional — only version clash detection can be performed).
e Simulate (Fully functional minus clash detective)
e Freedom (Free Viewer)
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1.3 Navisworks User Interface
Navisworks is built up of an application menu, quick access toolbar, ribbon and dockable windows.

A new window is opened by selecting View » Windows and ticking the appropriate box. These windows
can be docked as tabs
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Home Viewpoint -
E | Background
] [5 |CSTALP-00X-M3-A0000L, .+ | | % .w_ i FD 8 Load Workspace +
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Cube| ~ Views Gid | 7 Screen View  |f50 Show Title Bars | KS e AENoTdce
Navigation Aids Grids & Levels ~ Scene View | 01 o petective
| TitheLiner Save points q
[] preenter [LevelBreakdown
| Arfrtar Al Disiplines
Front_all Discipines
| Scfpter ok
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Titehh Catalog Z Ramp € 00
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B2 Plant Room
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i
Sefction Inspectar \
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Firhl Comments &
] Messure Tools 2
| 5afed Viewpaints
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Pigh View
| Seftion View
[ seftion Plane Settings
Apearance Profiler
[ ] prdject Browser
[ Fird Item in Other Sheets and Models
Application Quick Access Ribbon Windows Dockable Window

Menu Toolbar

TIP: Right Clicking a tool on the ribbon gives the option to add the tool to the Quick Access Toolbar.
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1.4 Useful windows to open
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Navisworks has many windows that can be opened when required, if you cannot see a window you are
expecting to see, check the windows listed in the view menu.

As with any tool, different users prefer different settings in their workspace. How your workpace is set up
is not important but above is a standard workspace.

TIP: Navisworks is best managed using two monitors to allow the maximum amount of model viewing
space to be utilised. With all or most of the windows moved onto another monitor. Navisworks is not
cheap software, if your employer can afford it, they can afford a second monitor!
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2. Planning

The focus of this class is based around project reviews but it is important that planning takes place prior
to any coordination workshops to ensure the process is a success. Below are several documents that if
implemented effectively can greatly impact the success of BIM and design coordination on construction
projects.

2.1 Employers Information Requirements (EIR)

On any project it is essential to establish exactly what information is required. The EIR is a document
created by a client (or representative) or contractor and is used to communicate WHAT information is
required. This document should be included in the request for proposal documentation to communicate to
the tenderers what information is required to be delivered and any additional tasks that must be
undertaken such as attendance at model coordination workshops.

The EIR is a high level document, below is an example of the sections within WSPs EIR that we supply to
clients.

Introduction

e EIR Purpose

e Goals

e Objectives

e Terms and Definitions

Technical

e Software

e Data Exchange Formats

e Coordinates

e Model maturity Management
e Training

Management

e Standards

¢ Roles and Responsibilities

e Planning the Work and Data Segregation
e Security

e Collaboration Process

e Coordination and Clash detection process
e Systems Performance

Commercial

e Data Exchange and Project Deliverables
e Model Ownership and Use
e Delivery Strategy for Asset Information
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2.2 BIM Execution Plan (BEP)

In response to the EIR, the BIM Execution Plan outlines HOW and WHO is going to deliver the
requirements described in the EIR. The contents of this document must be agreed by the
design/construction team.

2.3 Model Element Ownership Matrix (MEOM)

Following on from the BEP, it is important to have a document that provides the schedule of delivery of
the requirements of the EIR liked to a programme or stage gates. The Model Element Ownership Matrix is
often included as an appendix to the BIM execution plan.

The MEOM links each of the systems (Walls, Floors, Windows etc.) to the stage gates (Brief, Concept,
Developed Design, Technical design, Construction, Handover, use). Using a method of maturity
management such as Level of Development (LOD), each systems agreed LOD must be mapped against
the stage gates on the project, in addition, the ownership of the delivered information may change as
contractors come on board, this document will outline what stage this activity will be completed to allow
the project BIM Manager to manage the change effectively.

The project BIM manager may also wish to include required attributes as part of this table as a way of
defining the Level of Information to be delivered as well as the reliability of the geometry information.

|
Project: 66 Chilton Street [pate: [1.11.13 | /.. ws P
Reference: [version:  [w10 | //
Prepared by: Michael Boyd
Contact:  mishasl hoyd@wspgronup com
< Discipline Filter ] | | | | | |
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rroeneneea M@ o|o|lo|olojolololololo]jolo|o o B )
o o|ojo|lojo|lo|ojo|jo|lo|o|o|glo|jo|o|O
e Tolo|o[o|lojo|o|o|ololololo|olo|O|o
o) v @ &a|o|jojo|lojg|lololog|lo|lololo|o|d FLP | 0 | AP | am
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i o|ololo|olg|olo|lololg|lglglolalg|O
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oFFieuEE] o|lojololololojololololololo[o]o|O
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2.4 Attributes

The strategy for attribute requirements should form part of the EIR and the BEP and in some cases also
in the MEOM. It is useful to provide a table to indicate what attributes are required at each stage to
communicate requirements to the team but also to prevented waste by suppliers including too much
information too early.

RIBA POWV 2013 Stage Gates

STAGE 2
STAGE 3
STAGE 4
STAGE 5
STAGE 6

Attributes

GUID
Project O | %] | |
Building O | | M M s o
g o
Model Author M| ¥ | ¥ | @
IE =
Location O | | | | g S
"
v -
System O %] | ] %] ke %
E o=
Type 0| @ | ¥ | @ | 2 N
@
Description O i | M | g" &
¢ R
LoD 0| @ | ¥ | ¥ | @ .-
Uniclass O O | | |
SFG20 O O ~ M ~
Status O O O | | 4
= a
Asset Tag O ] [ M | 1:%3] £
e
Trade Contractor O O O | M O
L
Manufacturer O O O | | o

TABLE 6 ASSET INFORMATION DELIVERABLES

But there is a key attribute that should be included within every element on any construction project.
LOD (Level of Development - or equivalent)

It is important to give model suppliers a method of communicating the maturity of the information they are
issuing. Traditionally this has been completed via drawing sheets stamped FOR INFORMATION or FOR
CONSTRUCTION but how does this process transfer into the BIM workflow?

In addition a drawing sheet may indicate that everything on that drawing is ready to be issued FOR
CONSTRUCTION but there may be a bubble cloud indicating that an area is ON HOLD or IN
ABEYANCE. How does this process transfer into the BIM workflow?

By ensuring model suppliers include an object level attribute for every element in their model. They can
communicate the maturity of the information they are issuing. This can also be used by the BIM manager
to validate the information against the agreed Model Element Ownership Matrix.

TIP: Adding a project parameter for the LOD attribute is easy to implement on each project but ensuring
your companies Revit template has an LOD parameter included as a shared parameter within elements
will mean you are ready for future projects.
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2.5 Meeting Planning
For successful model coordination meeting throughout the design process, meetings should be diarised
in advance. There are several types of meetings related to BIM on projects

Kickoff meetings

At the start of the project it is essential to host a BIM kick-off meeting, the project BIM Manager will
introduce himself and his team to the rest of the project team members, discuss the BEP and outline the
BIM Strategy on the project. This meeting can also be used to highlight any concerns team members may
have with the protocols highlighted in the BEP.

BIM Strategy Meetings

At various stages, the senior project stakeholders will be invited to BIM strategy meetings to assess if the
project is on track for achieving its goals outlined in the EIR and BEP. The frequency of these meetings is
entirely dependent on the project program.

Model Coordination Meetings

There is also a requirement to hold regular BIM Coordination meetings. Prior to the BIM Coordination
meetings the BIM Manager/Coordinator will have prepared a report of the clash instances and model
errors found in the federated model, the team will discuss and resolve these issues as a team. The
frequency of these meetings will depend on the stage of the project but it is expected that by the time the
project is into late design development the project team members will be meeting on a fortnightly basis.

TIP: It is important to get the dates into the diary early, send outlook calendar invites to remind attendees
not only of their required attendance but also to upload their model files. If the model coordination
meeting is on a Wednesday, set an appointment in their outlook calendar to upload their model files the
previous Friday, little things like this make all the difference.

10
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3 Process

3.1 Project Setup — Viewpoints

When utilising Navisworks it is important to spend as little time as possible navigating around the model.
Having 5-6 people wait for you to find the right view is wasteful and tedious for the audience. To increase
the efficiency of navigation it is useful to set up some saved viewpoints in order to save time.

The list below is not exhaustive but | typically set up viewpoints for:

Every floor-plate

Sections through cores

Front Entrance

Each discipline

Complex areas e.g. plantrooms

ISR

To save the ‘home’ view, select the home icon above the view cube and right click anywhere in the
background and select ‘Set Current View as Home’

Home

Perspective

Orthographic

Set Current View as Home  Ctrl+Shift+Home
Set Current View as Front Ctrl+Shift+End

ViewCube Options...

Help

11
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3.2 How to Save a Viewpoint

Viewpoint Settings

Options Editor ’ e &) Right click on the background of the model and select
[l ||| e ‘Global Options’ expand ‘Interface’ and select
ke Un Override Material [¥] . . . . .
5 overnde tnear speed Viewpoint defaults. Ensure que Hlde./Reqwred
= o 400 Attributes and ‘Override Material’ are ticked and select
Viewpoint De Defauit Angular Speed (°/sec)  45.00 ok.
G-Links Colision
® Q‘uickP(opel
e Ensuring these settings are ticked will allow you to
el . . . .
e save views with different systems and models hidden
Neveptonol™ and also have different section planes turned on
[t » . . . . H
within different saved viewpoints.
(o ) [Cconced ][ 1o ]

Saving a viewpoint
Open the viewpoint menu by selecting View » Windows > Saved Viewpoints

Navigate to an appropriate location; manipulate the transparency settings, colour overrides, hidden items
and section planes.

i . i i i . Saved Viewpoints X
R.|ght cI.|ck in the saved wewpplnts window and select ‘Save T
Viewpoint’ and name appropriately. - (] All Disipiines

- - ﬂj Front_aAll Disciplines
Ritghrr | gt L[] Arch
|l L[ struc
L -1 mer
L1 Ramp @ 00
-1 Ramp @B1
(D B2 Plant Room
“ | @3 walkthrough Coord Issues (Ir
(N - ewic
- . 8
BWIC I
Save Viewpoint fems Selected Viewpoints
Add Animation Mew Folder
Add Cut Add Animation
Add Copy Add Cut
Add Comment Sort
Edit Import Viewpoints..,
Update Export Viewpoints...
Transform Export Viewpoints Report...
Delete Help
Rename il
Copy Name
Sort
Import Viewpoints...
Export Viewpoints... If the view is changed the viewpoint can be updated by right
Export Viewpoints Report.. clicking the saved viewpoint and selecting ‘update’:
Help
I I Crrowic
12
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3.3 Search Sets and Selection Sets

Open the set menu by selecting View » Windows > Sets

Sets can be used to create groups that share common properties, which can make it easier to review and
analyse information throughout the design process. There are two types of sets in Navisworks.

1. Asearch setis a group of items created by a saved search criteria. They are dynamic, and will
respond to change and update the set when revisions are added.

2. Aselection sets are one time selection groups, they are static and will need to be updated manually
if any changes are made.

@ ez S50 ¥ 31 I-| NOTE: The indicative symbol differs between search
() Selection Set and selection sets.
“ Search 5et

Selection Sets

Once the desired items have been selected, click on the ‘Save Selection’ icon [@] in the set menu. A

selection set is then created @ selection Set and can be named as appropriate.

It should be noted that selection sets will not be updated with new revisions of model files, e.g. if you
select all the walls within a model and create a selection set, when this model is updated the selection set
will not include the added walls as the selection is static.

Search Sets

A search set is created by using the find items tool. Home > Find Items. Select the model/s that are to be
searched and define the Category, Property, Condition and Value and hit return to search.

Find Items x
S Category Property Condition Value
[Standard - %
* Item Type Contains RC wall
CST-IMT-00-XX-CR-Z-0000 L.owd %

CST-PLP-00-XX-M3-A-0000 L.rvt
T-WSP-00-XX-M3-5-20001.
CST-HLE-00-XX-M3-M-00001.rvt

[¥] Match Character Widths
[¥] Match Diacritics

[ Match case
[] Prune Below Result
Search: [Defﬁult v]
[ FndFrst | | Fndiext | [ Findal [ mport... | | Export...

TIP: It is usually helpful to ensure the Match Case tick box is un-ticked in just in case some users are not
disciplined in their naming of elements and attributes.

13
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If you are unsure what attributes to search for then select an item then look at the properties window.

— =

Item | Material | Revit Material | Autodesk Material | Element 1o [ * |
Property Value

Name Basic Wall

Type Walls: Basic Wall: 540 RC WALL

GUID 4120292702 19-48a5a6c 1 -dB6abeScbice
lcon Geometry

Hidden Ne

Required No

Material Concrete

Source File CST-WSP-D0-204-M3-5-20001.rvt

Layer LEWVEL B1 S5L

Once the search has selecﬁj the desired items, select the save search symbol &% on the sets window.
The search set s created

search Set and can be renamed as appropriate.

Search sets can be transferred between projects this saves a great deal of time if you have repetitive
workflows with model coordination and clash detection. To import or export search sets just right click in
the sets window to import/export an XML file.

3.4 Why are sets important?
It is generally not very efficient to clash detect one model against another. The amount of clashes
generated will be many and the clash groupings will not be focused.

Instead of Creating a Clash Test of Struc V MEP, the BIM Manager could utilise search sets and setup
and run a test on Struc Walls v MEP Ducts. This would focus the discussion at the model coordination
meeting and help test for priority issues.

14



C05945 - Introduction to Project Reviews Using Navisworks

3.5 The Clash Detective — an Overview

The clash detective is a powerful tool used to compare and contrast models, sets and properties across
multiple disciplines to identify potential design conflicts early to be resolved before the design is taken to
site.

Open the Clash Detective by selecting Home > Clash Detective or View » Windows > Clash Detective or
Ctrl+F2.

Clash Detective x

# Struc v Mechanical /Y Last Run: 20 October 2014 13:01:01

Clashes - Total: 8 [Open: 8 Closed: 0}

Name Status Clashes I New E.Acti\re I Reviewed IAppm\red Resolved
/0 Arch v Struc Ramps old 0 0 0 0 a 0 :
/Ay Strucv MEP old 1188 1178 10 0 0 0
/M Strucv Mechanical old 8 8 0 o 0 ] D
/0 Strucv Electrical old 3 3 0 0 0 0
/0 Strucv Piping old 1 1 0 0 0 0
LA - - — . - - . - - - - ¥
“ | m | v
‘ ﬁ. Add Test J \ Reset All ‘ Compact All | Delete All J \E"—e Update All ,@ -
‘ Rules Select | Results | Report ‘
~Selection A -Selection B
| Standard - | Sets -
B[g] CST-IMT-00-XX-CR-Z-00001.nwd B Arch
[ CST-PLP-00-XX-M3-A-00001.rvt e Struc
[ -WSP-00-XX-M3-5-20001. B MEP
CST-HLE-00-X-M3-M-00001.rvt " MEP Walls
— " MEP
|— " BwIC
% g3 Piping
| @3 Electrical
i Mechanicall
B WALLS
™ 2.2m Drive Aisle
I L * |t o * | =h
~| (0] [2]% - (B¢ %]
- Settings
Type: |Hard v| Tolerance: U.ﬂﬂi m
Link: |MNone * | Step(seck |01 ‘ sundest ‘
Composite Object Clashing

15
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3.6 Creating a Test
Within the clash detective window, click ‘Add Test’

Clash Detective

[E Add Test | 53

Add Test
Create a new clash test.

“ There are currently no clash tests defined.

| Rules | Select |Results | Report|

In the select tab of the Clash Detective, a clash test is defined by selecting model, sets or properties in
Selection A against the chosen models, sets or properties in Selection B.

A Testl Last Run: <MNone>
Clashes - Totak 0 (Open: 0 Closed: 0)
Mame d | [a d Beacolved
O
I [& Add Test ‘ I Reset All | Compact All ] Delete All | |E" Update All l &~
Rules Select | Results I Report |
-Selection & -Selection B
[standard | [sats -]
GI'—PI.P—OO—XX—HB—A—MOOIM B85 Struc o
GI'—WSP—IH}—X}(—MB—S—ZOOO].M ) Struc
-HLE-00-XX-M3-M-0000

'Stmc—kamps

Shru

i
';“

% struc-Structural Columns

B struc-walls

El/]=] &) (][] Bl/]=] ] (2]=]

uC: .I i
truc-Structural Framing

~Settings
Type: |Hard » | Tolerance: 0.001m
' Run Test
Link: [None ]| stepseq: 01 s

Composite Object Clashing

The content of the test is determined in the drop down menu below Section A / Section B. Models are
categorized as ‘Standard’ or ‘Compact. Properties and sets can also be selected to run clash tests
against. These categories can also be clashed against one another, for example the Whole MEP model

vs Structural Framing (as above)
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3.7 Clash Rules

Just because there is a clash does not mean it is an important issue. It is important to weed out the false
positives before any clash grouping takes place. To create intelligent clash results and save time
throughout the design process, clash rules provide the functionality to ignore clashes that are not ‘real’ or
relevant. There are 6 default rules in the Clash Detective Rules tab:

Items in same layer

Items in same group/ block/ cell

Items in same files

Items in same composite object

Items in previously found pair of composite objects
Items with coincident snap points

New Rules

Customised rules can be created to ignore particular clashes using rule templates below. Settings these
rules will stop the clashes from being reported in the clash results.

e Same Property Value
- Items that are found on the same property value
e Same Selection Sets
- Items within the same selection set
e Specified Selection Sets
- Items within two specified sets
e Specified properties with the Same Value
- ltems that share the same value within two different properties

As an example, it is common for Architects to model structural items within their files in the early stages of
a design, the phased removal of this structure in the Architectural information should be noted in the
project BIM Execution plan. Prior to this removal, the project BIM manager can set a rule to ignore
clashes between the structural elements inside of the Architectural model and the elements inside of the
Structural Engineers model, thus reducing the amount of clashes returned.

& Add Test| | Reset All |CompactAII | Delete All | ||E“:,Updateﬁ.ll | -

‘ Rules | Select IResuIts | Report |

~Ignore Clashes Between

Items in same layer

Items in same group/block/cell

Items in same file

Items with coincident snap points

Items where one item is in selection set 'Struc Model' and the other item is in selection set "Structural C ...
Items which are both in selection set "Structure->Structure’,

Items which are both in selection set ‘Architecture-> Architecture'.

|Items where one item is in selection set 'Struc-=Struc” and the other item is in selection set "Arch-= Arch-PT
Items where one item is in selection set 'Struc-»Struc’ and the other item is in selection set 'Arch->Arch-5h
Items where one item is in selection set "Struc-=Struc-Walls' and the other item is in selection set "Arch-= A/
Items where one item is in selection set 'Struc->Struc’ and the other item is in selection set 'Arch->Arch-Ce
Items where one item is in selection set 'Struc->Struc ... Structural Columns' and the other item is in selecti
Items where one item is in selection set "Arch-=Arch Rooms’ and the other item is in selection set "Struc-=&
Items where one item is in selection set 'Struc->Struc ... Structural Framing' and the other item is in selectis
Items where one item is in selection set "Struc-=5truc’ and the other item is in selection set "Arch-=Arch Ro
Items where one item is in selection set 'Struc-»Struc ... Structural Columns’ and the other item is in selecti
Items where one item is in selection set '2.2m Drive Aisle’ and the other item is in selection set "Struc-= Stru
Items where one item is in selection set 'Arch->Arch-Floor' and the other item is in selection set 'MEP-= Pip
Items where one item is in selection set 'Arch->Arch-Ceilings' and the other item is in selection set 'MEP->
Items where one item is in selection set "Arch-=Arch Rooms’ and the other item is in selection set "MEP-» I/

IR SRS S R R K A P e I el R R R R i R e P SR S TR

T ) ) ) ) )
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3.8 Running a test

Back to the select tab. Before running a test. It is important to select the type of test and the tolerance to
be taken account of. There are two major types of test Hard and Clearance. Hard clashes being two
objects that intersect each other and clearance clashes being two objects that are in proximity to each
other but not touching. Clearance tests could be used to test maintenance zones, penetrations around
structural columns etc.

Settings
Type: |Hard v| Tolerance: 0.001 m
Run Test

Composite Object Clashing

Tolerance refers to the precision of the test. It is generally ok to leave this down at 50mm in the early
stages of a design but moving in to detailed design would require the tolerance to be 1-10mm.

TIP: There are two Hard clash type settings: Hard and Hard conservative. It is advised to keep the
settings to the ‘Hard’ type as standard and on occasion change the setting to Hard (Conservative) as a
check for missing clashes. The Hard Conservative clash test will return many more clashes. This is to do
with the way Navisworks works out intersecting faces and objects.
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3.9 Clash Results

Once ‘Run Test' has been selected. Select the Results tab to view all clashes in the test. The results

CO5945 -

delivered at this stage will be for each individual clash found. Note: This information must be filtered

grouped and prioritized prior to the model coordination meeting. Turning up to a meeting with 1000s of
clashes to go through is not advisable. The display settings of the clashes can be changed from ‘DIM

other’ to give some context to ‘HIDE Other’ to focus in on the clash.

Clash Detective

# MEP v Struc Framing /&

Last Rur: 19 Movember 2014 17:40:20
Clashes - Total: 37 (Open: 37 Closed: 0)

Mame Status

I Mew IActNe I Reviewed

I Approved Resolved

IlE.MdTestJ [ Reset All ‘ Compact All ‘ Delete All ‘ lﬁ, Updatemll

|2 - |

L -? - HL_Attenuator_Rectangular
-?é HL_Attenuator_Rectangular

Al Attenuator Rectano

l[ ﬁNew Group | [ Locg' [ w| \‘QR Assign ':"‘“| w [ﬁ[% MNone v‘ l':":} |%AJ l@ Re-run Test‘
Name @ ;‘ Status  Level Grid Int... Found él - Highlighting ——— et
p =}
® Clashl New » Townho. G(11)-5 17:40:20 19-11-2 l Ttem1 [ Ttem 2 ] 0 =
® Clash2 New w Townho.. G(14)-4(.. 17:402019-11-% <
@ Clash3 Mew = Townho.. 3SA(1)-G(9) 17:40:2019-11-2( Highlight all clashes g‘
@ Clashd New +« Townho.. G(6)-6 17:40:20 19-11-2( ~leolation G
@ Clazhs MNew » Townho.. E{1)}-7 17:40:20 19-11-2 [ Dim Other rHid'e Dther‘
B Clachi Mo — lousl BY BT TLN 4700 10,41 M [/] Trdnsparent digming
S |_ m ! [¥] adto reveal L6 |
| W Items |
Ttem 1 =] Highlight = Item 2 Highlight [[o“u] [+
Itern Mame: HL_Attenuator_Rectangular Item Name: UC203x203x46
Item Type: Duct Accessaries Item Type: Structural Framing
T.GI' HLE-00-XX-M3-M-0000L.rvt & ?.GI' -WSP-00-XX-M3-5-20001.rvt P
?i LEVEL B1 _?i LEVEL DO
-?202 Duct Accessories —? Stnicl:ural Framing L
---?202 HL_Attenuator_Rectangular %2 UC-Universal Columfps =

2 UC203%203x46
—?%IJC Universdl Columns
— Al D3x46 Ird
7

Introduction to Project Reviews Using Navisworks
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3.10 Grouping Clashes

So we have learned how to create some clash tests and we have found some issues, now we can take
them to a coordination meeting right? WRONG!

Do not under any circumstances bring 100s and 1000s of clashes to a coordination meeting or worse still
send out a clash report indicating these clashes to a team. You will lose credibility and also find that you
are completely ignored. Grouping clash results by area, group or similarity assists in highlighting issues
that affect certain stakeholders and specific project priorities, which will assist in creating efficient
coordination meetings by turning clashes into coordination issues.

NOTE: There are several methods of grouping clashes; the method | note below is the method WSP has
evolved into using as we find it far more efficient than other methods.

Step 1: Select all the individual clashes and use the ‘Group Selected Clashes’ button: | [2] | to group the
selected clashes into one single clash group.

Step 2: Select elements within the clash group using the selection tool or the sets you have created
earlier then change the filter by selection to ‘Inclusive’ this will filter out all the clashes that do not
intersect the elements you have selected.

Clash Detective L=

# MEP v Struc Framing A Last Run: 19 November 2014 17:40:20
Clashes - Total: 1 (Open: 1 Closed: 0)

sy | @aup uomaps

Mame status | Clashes | [mew | [lactive | Reviewed [ 2pproved | Resol
4

IE.AmTest | ‘ Reset All ‘ Compact All ‘ Delete All J ‘@.Uudateml I iR

Rules | Select | Results | Report

[[ * New Group | X "';AE]@HE‘Amgn |.:’ @ HiNane vJ If‘_'ﬁ %AH% RerrunTutJ | ‘l‘.!

None
Name (G107 Status  Level GridInt.. Found Shows all diashes
b 4] New Group New [l Townho.. G615 17402

Exclusive
Shows clashes where both dashing items are
selected

Inclusive
Shows clashes where at least one dlashing item
is selected

[/] Transparent dimming
[¥] Auto reveal

- Viewpaint
Auto-load -
Animate transitions

Focus on Clash
Simulation
Show simulation W

~View in Context

‘] [ro—]

[+ tems

|
Hem1 [ ] Highlight “&] | s I Ttem 2 Highlight [[J—QIF’KI

Item Name: HL_Attenuator_Rectangular Item Name: UC203x203x46
Ttem Type: Duct Accessories Ttem Type: Structural Framing
BG[-HLE—M-XX-MS-M-IIIIWLM - BG[-WSP-W-H-MS-S-MLM -
e @2 LEVEL B1 SSL ¥ |
Il £ LEVEL 00

2% Structural Framing
oncrete - Rectangular Beam
-Universal Columns

HL_Attenuator_Rectangular
%2 HI_Attenuatar I
I

NOTE: This method of grouping clashes works seamlessly in 2014 but Navisworks 2015 is very
buggy and this method will not work effectively. Autodesk are aware of this. We feel the efficiency
this affords us is more important than the minor enhancements inherent in the 2015 release.

TIP: Use the spacebar and the selection tool to select elements with a window.
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Step 3: Now open up the group again and you will see a reduced amount of clashes, these are the
filtered clashes, in the example shown we have four beams clashing. Group these clashes together and
rename the group with a numbering system according to the test e.g. SYM_Mech-001

I[ *jNew Group [ [°§] ngAssign ‘ 2w | |G | [ﬁh[ndusi\re = | I“FB |%§| I@ Re-run Test|
Name ;‘ Status  Level Grid Int... Found ~Highlighting —————— =
4 [2] New Group New + Townho.. G(11}-5  17:40:20

G(11}-5 17:40:20 1 Use item colors -

G(14)-4(.. 17:40:20 1 [] Highlight all clashes
SA(1)-G(9) 17:40:20 1 IEGEG—G—__

cos oz

/| Transparent dimming
[¥] Auto reveal

sBuipas Aejdsig |

Step 4: Reset the filter by selection to ‘None’ and you will notice that these clashes have been removed
from the clash list. Carry this process on until all of your clashes have been changed into pragmatic clash

groups.

NOTE: You may wish to group by area, or by system, keep in mind the goal is to group into manageable
chunks that can be resolved easily.

Step 5: For each group, manipulate the model to a visually informative view of the clash and save the
view point by right clicking below the camera icon next to the clash name and selecting ‘save ‘viewpoint’

Rules Select | Results | Report
[[  New Group ‘ ‘ A @llggmsign ‘ @ h’%lmlusive vJ SICTS [% Re—mnTtst‘

Name (G107 status  Level Grid Int... Found ~Highlighting
Ttem 1 Ttem 2
Load Viewsoint sl
Use item colors -

[7] Highlight all clashes

Save Viewpoint

sBumas Aejdsig |

~Isolation

Dim Other | Hide Other

Transparent dimming
[¥] Auto reveal

Facus On Clash

Delete Viewpoint
Delete All Viewpoints
~Viewpoint
Auto-load -
Animate transitions

Focus on Clash

~Simulation
Shaw simulation ‘ W

View in Context
( Al

< | .

[~ rems |

Step 5: Add an informative comment to describe the clash via right clicking over the comment @ icon
next to the ‘Save Viewpoint’ icon.
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Step 6: Do this for each of the clash groups you have created. You will find your 100 and 1000s of
clashes have become 10s possibly 100s of pragmatic clash groups.

3.11 Other uses for the Clash Detective

Why not use Navisworks and the clash detective to pro-actively check for design issues that may not
necessarily clash. In the example below the architect modelled the required clear space in the basement
car park as a generic volume. We then created a clash test to ascertain if anything in the model impinged
into this required clear space. And there were plenty of issues. See below images.

22



C05945 - Introduction to Project Reviews Using Navisworks

3.12 Walkthrough Design Issues

There can be design coordination issues that are not highlighted in the clash detection process as they do
not physically clash. A walk through the model can be an effective way to spot these coordination issues
and highlight them to the team.

=-{3 Walkthrough Coord Issues (Intervention 12) To manage the process effectively, make sure you save a viewpoint

Walk_004_Under ramp ducktwork . . . .
Wak_020 Level 15lantern dazingissue 10T €@Ch of the walkthrough coordination issues in a manner that can

Walk_24_Material Issues be easily recognised.
Walk_47_Pipework Location
Walk_57_Exterior lighting
Walk_&0_Missing terrain geometry
Walk_65_B1, door to lift lobby
Walk_68_Ramp Pipewark
Walk_71_Car park railing and pipework
Walk_72_B1MEP coordination

TIP: Sometimes the walkthrough design issues are more important than the clash detection issues. Make
sure these are discusses and actions taken for resolution.
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3.13 Clash Avoidance using BIM 360 Glue

360 Navisworks is not the only tool in a BIM manager’s toolkit for improving coordination. BIM
360 Glue is a cloud based, simplified coordination and basic clash detection tool that can be
used by the model suppliers between the model coordination meetings to try and pro-actively
avoid clashes.

Using the mark-up tools in Glue, designers and clients can share issues and collaborate on a common
platform.

Roof Steelwork Issue

W Michael Boyd

05/02/14 1512

oty proec members f oo Stk e
T
= ena
e —
e —
Tony Coulson tony.coulson@wspgroup.com
e s
B Gomisotei ssaperoppachiscrecon
|

Frank Mcleod frankmeleod @

H|  Message: (optiona)
g BT

thessue of
0 the next model cooridination workshop?

Cancel

In some cases designers do not have access to Navisworks manage. Using BIM 360 Glue will allow them
to clash detect their own information against others to test coordination prior to coordination meetings.

@  Archaecture vs Suuciue (279)

Geou By Ungrowped @T8)

Nosfcatons | AB(EVE}

Magritude: 125 e
W i it [246330] Wi e [26523)
B30 Archtachral 30 - Sructurd
= 5 Sagmert
= el (78) = Sruchura Framing (434)
& Bamc ot (70) = Weicn Parge (432)
5 Intaric - Paon (-4} (4] 5 b 381
Basic Wal| Wowde

Add comment to Clash177

NOTE: The clash detection tools in Glue are currently no match when compared to Navisworks.
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3.14 Mobile working

BIM 360 Glue also has very strong mobile functionality to bring all project stakeholders into the
collaborative process. Currently supported only by iOS it is possible to navigate and mark-up models, with
some basic manipulation tools.

For users who are not tech savvy such as design
i j ) £ Models CST-IMT-00-02-CR-Z-00002

managers and clients, BIM 360 glue is an invaluable

tool for immersion

iPad & 15:17

£ Models Chiltern St

TIP: Save an NWD file to Dropbox or similar, then, using an IPAD, select Open With. Select BIM 360
Glue app and you will be able to navigate your NWD file using the BIM 360 Glue tools.
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3.15 Clash Detection & Clash Avoidance Workflow
Between the model coordination workshops it is expected that designers share models and coordinate
between themselves. The implementation of BIM 360 Glue allows designers a method of quickly Glue’ing
models directly from Revit or from Navisworks to be ‘Merged’ on the BIM 360 Platform. Once this process
has been set up, it works seamlessly. Designers can quickly ‘optioneer’ designs and analyse and
appraise their information prior to the model coordination meetings.

Typical model coordination workflow:

- Week 1

- Monday

~ Tuesday

~ Wednesday

~ Thursday

Design Team

Clash
Resolution

Clash
Resolution

Clash
Resolution

Clash
Resolution

Clash
Resolution
Model Upload

Information
Manager

Tuesday Wednesday Thursday
Design Team Clash Clash Co-ordination | Clash Clash
Resolution Resolution Workshop Resolution Resolution
Information Model Review Model Review Co-ordination | Meeting Report
Manager Clash Grouping | Clash Grouping | Workshop Minutes and
Clash Report Clash Report actions
In Technology Terms:

- Week 1 Monday Tuesday Wednesday Thursday ' Friday
o !O !O mo mo !O
Information
Manager

\ Week 2 Monday Tuesday Wednesday Thursday

Design Team

mo

KO

M

mo

!O

Information
Manager

M

M

M

NOTE: Clash avoidance refers to the proactive checking and coordination activities, Clash detection is
reactive validation. Currently BIM 360 Glue cannot match Navisworks for functionality, but when it can, it
will be a game changer!




4 Reporting

So we have created our clash tests, grouped the clashes into pragmatic coordination issues and saved
viewpoints and appended comments. Now we need to communicate what we have found to the team.

CO05945 - Introduction to Project Reviews Using Navisworks

4.1 Clash Reporting - an Overview
The Report tab in the Clash Detective creates reports outlining the grouped clash results. The information
and tests included in the report can be customised according to the desired content, clashes, clash status

groups, tests and can be produced in a variety of formats. The production of a clash report is a people

management tool which communicates the clash test results and comments.

o0 hM~LNE

Click ‘Write Report’

| Rules | Select |Re5ults‘ Report ‘

Tick the desired content (Less is more!)

Select the clash option (Group Headers is usually most efficient)
Select the clash statuses to be included (Is there a need to include Approved or Resolved?)
Select the type of report (Individual or combined?)
Select the report format (Dependant on your workflow, HTML Tabular works well)

-Include Clashes

- Contents

Summary

Clash Point
Date Found
Assigned Ta
Date Approved
Approved By
Layer Mame

Item Path

Ttem ID

Status 1
Distance
Description
Comments
Cluick Properties
Image
Simulation Dates
Simulation Event
Clash Group
Grid Location

5 £ ) 0 £ ) ] 0 0 £ ] ) £ N EN L

For Clash Groups, include:

Group Headers Only

=) 2

D Include only filtered results

Include these statuses:

[¥] Mew

|| Active
Reviewed
Approved 3

|__|Resalved

- Jutput Settings
Report Type 4

Report Format 5

6

[ A1l tests (combined)

~ | [HTML Tabular)

Preserve result highlighting

. | Write Report

NOTE: It is the authors experience that a huge amount of time is wasted trying to produce aesthetically

pleasing clash reports. Remember, the clash report is not the goal! The clash report is a checklist for the

model suppliers to go through when resolving issues. Ideally suppliers should be using Navisworks and

BIM 360 Glue to go through the issues.
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4.2 Report Management

For the purposes of this presentation, we will cover the two types of report that WSP implement in our
workflow. The ‘HTML Tabular’ and the ‘As Viewpoints’ report. Using both these reporting methods allow
stakeholders to use the Tabular report as a resolution checklist and use the Viewpoints to highlight the
clashes inside of Navisworks should they only have access to Navisworks Simulate or Freedom.

HTML Tabular: Creates an HTML file complete with images and in a table format. It can be opened in
programs like Excel. If an image of a clash is clicked, an enlarged version will open within Microsoft

explorer.

‘!ws P Intervention 12 - Clash Report

Toleronce | Clashes | New | Retiee T eviewed | Approved | Resowed | Type | Srotus |
[ achy = e ] |

I 1 I | ) (2]
E— - - e - ftem3
image | Cishdame | Grdlocation|  Osoround | Assigesio Cissh poine Hem 0. tayer pamn itom B tayer Path Commants
File> il > CST-PLP-00 100 M13-8-00001.rvt File > File » CST-WSP-000K M3-5-20001.rv
- Avs_Floords0 | Fsiste | 2014/6/9 130224 X528099.55, V18176273, 11880 | Element 10: 25371230 8 =82 Flaors » Hoor > 1088-FLY S0mmStaff| Eement/0:1796039 | (EVELBZ | LEVEL B2 Foors » loar > 1400 RE SLAB »|
> Fioar Floor
|22 wkmabss - 201474724 104905
| File> File > CST-PLP-00-X06M3-A-00001.rvt File > File = vt| Multiple Levels,
AvS floor57 | ESishe | 2014/4/20 085343 X(528005.67, 18176428, 120 80 | Elment 0: 19520057 w2 5025 Wale > Basle Wall PLSZOL. | lement/D:3230261 | EVELBISSL | > LEVEL B S5L> Floors > Flaor » 200THE ‘s, Additionat Clszhes.
WARD_ WAL PLASTER-15 > Baic Wl S8 > Hoor
Fle> il > CST-PLP-00-10M3-A.00001.rt. File > il » CST-WSP-000C 13-5-20001.rv |
S floord63 | D::ste | 2018f6fa 130224 XS28094.12, V-B1765.94, 120,64 | Element 10: 24361384 2 5825 Stairs > St > Core St Typical> | Element /0: 3230261 | LEVELBISSL | > LEVEL 81 55L> Floors > Floor > 200THK
Stac> Stairs > Conerete - Prast Conerete 5B > Hoar
!’ File > File » CST-WSP-000K M3 5-20001.rv |
AVS_floor075 | DTHDSite X528086.00, V18175025, 12449 | Element D: 22104937 " LEVELOD > LEVEL 00 » Floors» Fvor » 275 THK RAMP |
81> Rooms > USHTWELL B1.14 1ERELED - Pee o R IR

Tolerance | Clashes | __mew | Aciive T Reviewed | Approved | Resoved | Tyoe Srats
[ v structural cotumns [oEes fempef Mo s I o [t | 0 Jww

EEE

hem

Imsge Clsh Name | GridLocation | Dite Found | Assigned To | Gissh point hem D Layer Path N tem D Layer Path T Comments
Fie = Fils = CST-WEP-00-XXC M3 & 2000L.rv |
Fil > il > CST-PLP-00-00M3-A-00001. vt >LEVELOD s > -
A Columns 083 | F7:Site | 2014/10/20 17:58.20) x528098.60, v-181752.95, 1:27.20 | Element ID: 3385247 [ 00 > Wolls > Basic Wall > 108B-WL-470: | Element ID-2639141 | LEVEL0D
PUNTH > Basic Wall
st CHS139. 780
T File > il > CST-WSP-00 XX W35 2000L.rvi |
Fil > File > CST-PLP-00-20C M3-A-00001.4 2 LEVEL 36 » Structural Columns > SHS-
AS_Columns.086 | C5:Site | 2014710720 17:58.20. X57800.31, y181766.59, 1781 | Element 1D: 24342193 1 2 LeveL1s
CONC Plinth > Basic Wall SH5160x160¢10.0 > SHS-Square Holoy
Sections col
1evEL12

Fil > File > CST-PLP-00-00M3-A-00001, 1
AVS_Columnc.038 | G.:ste | 2018710720 17:58.20 528082.18, V181766.02, 13283 | Eloment 1D: 22571718 1 01> Walls > Basie Wall >P228. | Element D: 1455373
SVP_LINING-100 > Basic Wall > Metal

—
File > File > CST-PLP.00-0M3-A-00001. vt
AvS_Columns 087 | G3:Ste | 2014/10/20 17:58.20( S28112.61, 18177243, 1:65.03 | Element 10+ 16520993 12 125 Floors » Hoor > 100mm Floar Fnish > Element 101390703
Faar
——
~

File > Fila > CST-WSP-00-XK-M3:5-20001. vt |
2 LEVELO1 > Structural Colurns » Canerete |
s Rectangular > 35031200COLUMN >
Concrate Rectangular

e
\\ [ A Frp— ey R SR PR—

teveLBiss |

File > File > CST-WSP-00-KXM3 5 2000Lrvt
> LEVEL 81 551> Structural Columns >

TIP: When selecting a location to save your clash report, avoid your desktop, unless you are saving to a
folder on your desktop prior to saving to your network. The report will be generating a significant amount

of information especially if you export several tests as one combined report.

As Viewpoints: Exporting using the ‘As Viewpoints’ Clash report ‘ SRR

will create a folder within the saved viewpoints window named - Intervention 12 - Gashes

according to which clash test is selected. The clash groups will be '
listed as they are named in the results tab of the clash detective.

23 Arch v Struc Floor
{:D Reset Appearance
H-{C3 AvS_Floor-050
#-{{1 AvS_Floor-057
70 AvS_Floor-083
i3 AvS_Floor-075

i}
=
[ ]

ED Reset Appearance
w23 AvS_Columns-083
w23 AvS_Columns-086
-3 AvS_Columns-087
-3 AvS_Columns-083
-3 AvS_Columns-089
-3 AvS_Columns-090
-3 AvS_Columns-091
-3 Arch v Struc Framing

Arch v Structural Columns
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4.3 Trending Coordination

The saying goes: “If it cannot be measured, then it cannot be improved”. How can we check or trend
coordination on a project? By trending the amount of entities within a federated model against the total

clashes found we are able to generate a clash trending overview. See below:

Total Entities within Model V Clash Amount

Generating the total entities:

To generate the total amount of entities in the model we must use the Find Items tool.

Animation  View Output Render BIM 360  iConstruct 2014

% [Cé}] (Eé (g% E {7, Find ems E}ﬁ] '

Select Save Se\ect' Selectv Selection o Find ltems {Shift+F3)
Selection All Same Tree

Select 8 Search =

ST

Append  Refresh Reset  File
= All.. Options

Project =

Searches the scene for items based on specific parameters.

To search for items, you need to setup a search statement
The search statement contains a property (a combination of
category name and property name), a condition operator, and a
value 1o be tested against the selected property. For example,
you can search for Material that Contains Chrome

£325 | 234) uoipsjEs

A Arch v Electrical /& Press F1 for more help

Ensure all models are selected then search for items that have a name defined. Notice the properties box

now lists the amount of entities in the model. Note: Searching for different parameters will generate

different results so be consistent!

Find Items L Properties I
Search in: L
Categor Proper Condition Value
Standard - - oy BTy
“ Item MName Defined
79924 Items Selected
Match Character Widths
Match Diacritics
[ Match Case
|| Prune Below Result
Search: [Deﬁult v]
FindFirst | [ Findhext | [ Fndal | [ wmport... | [ Export..

Generating the total clash count:

Within the clash detective you can run separate clash tests against all models to get the total amount of

clashes with a model. Keep this run separate from your grouped clash tests.
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Though not the be all and end all of performance indicators; trending the clashes does provide a give a
sense of the level of coordination that is occuring on a project. Generally the clash percentage will
increase as the models become more complex, but there is a tipping point where they will start to
decrease as the project team embrace collaborative workflows.

Clash Trending

50000 I >
45000 i
40000 1
35000 i
2 30000 i 2
3 25000 ¢ >
Y 20000
15000 { A B
10000 1
5000
0
Federation1 | Federation2 | Federation3 Federation4 | Federation5 Federation6 | Federation7 | Federation8 | Federation9 | Federation 10
= Entities 20679 31267 31267 28677 33879 38731 38806 40794 42105 47228
= Clashes 2757 4017 4017 4305 4723 4300 4124 7622 8079 7907

See point A: This is the tipping point where the clash percentage started to decrease.

See point B: There is a jump in the clash percentage as the project moved to the next stage gate so the
tolerance was reduced from 50mm to 1mm.

Note: The above is just one example of capturing data from the model coordination process. Data could
be captured to highlight issues that have been unresolved for several meetings. Information could also be
used tend resolution by discipline to highlight any trades or disciplines that are not pulling their weight.
BUT: This process should not be used as a weapon, everyone should benefit.
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5 Meetings

Model coordination meetings are an integral part of the collaborative process but if not managed correctly
participants can become disengaged with the process and see the meetings as a hardship they must
endure. With some planning and management this does not have to be the case.

There is no ‘correct’ way to manage meetings. This paper is in no way trying to dictate the exact
methodology to run the perfect meeting, feel free to pick up a self-help book at your local book store for
that. But there are some considerations and lessons learned that may be of use to the reader to keep the
team engaged in the process.

Golden Rules:

1. Meetings should NEVER be longer than 2 hours
2. Everyone should benefit from attending
3. Attendees must have authority to make decisions on the spot

5.1 Suggested Meeting Agenda

1. Previous actions
e Cover any actions (not clash related) taken at the previous meeting.
2. Overview of model, stats
e Stats of model entities and clash percentage
e Outstanding issues such as a discipline not uploading a model
3. Walkthrough Coordination Issues
e Run through the non-clash issues, most of the time these are more important that the
physical clashes.
4. Discipline issues
e Allow the disciplines 5-10 mins each to bring up any issues that is a priority to them.
Remember golden rule No. 2.
5. Clash coordination
¢ Inan ideal world the clash report and NWD file would be issued and everyone would
coordinate their own information. BUT, that is currently not the case. Use this time to
cover the priority issues.
6. AOB
e If you manage to get through all the clash coordination issues then well done. In a
two hour meeting you are likely to be able to run through 40-50 issues depending on
the complexity.
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5.2 In Person v Virtual

In person meetings are very helpful, especially at the start of a project. They allow a team to build rapport
and get to know each other. It is recommended that the first couple of meetings are managed in person.
The negative side of in person meetings is that they tend to take longer due to attendees catching up and
striking conversation so this makes them harder to manage.

Virtual meetings on the other hand can be a very effective time management tool. Attendees do not have
to travel to the meeting. If 4 people are travelling 15 minutes each way, this equates to two hours lost time
each meeting, in addition to attendees being unsettled from their desk environment.

Also, virtual meetings can pack in more than in-person meetings.
People are less likely to converse and keep their answers concise and
to the point. It is estimated that the content covered in a two hour virtual
meeting would need an in-person meeting lasting 3-4 hours.

5.3 Meeting Planning

As discussed earlier, planning meetings in advance will keep the design process on track and all
disciplines aligned. In addition to the clash grouping and report generation noted in previous section the
below checklist is a useful guide.

Have dates in the diary and outlook invites sent for meetings and model upload dates.

Have a set of the latest drawings to hand.

Catch-up with the disciplines beforehand, a quick phone call to help focus the meeting.

Collate stats on the model, Growth in entities, change in clash percentage.

Undertake a Model Review or Health Check on each disciplines model beforehand (See more in this
in the tips and tricks section)

akrwpdpE

TIP: There is absolutely nothing more useful than having the client involved in this process and attending
the meeting. It removes 90% of the petty issues between disciplines and focuses the process.

TIP: If you utilise virtual meetings, always remember to restart your machine 30 minutes prior to the
meeting. On occasion virtual meetings do crash. Restarting your PC cleans out the memory and prevents
this. NOTE: This tip also applies to presentations (I am speaking from experience)

5.4 Follow Up

We have had the meeting, so we are finished now right? WRONG

Remember it is people we are managing through the process, they need a reminder. There are a few final
steps to the process that if followed will improve results.

1. Send out minutes from the meeting with actions highlighted
2. Send out clash report and a published NWD of the federated model
3. Update attendees outlook invite to the next meeting with the action list
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6 Tips and Tricks

6.1 Keyboard shortcuts

Much of the Navisworks workflow is repetitive, knowing keyboard shortcuts makes navigation easier and
improves efficiency in your workflow.

The below list is not exhaustive but these are the shortcuts | use consistently.

e CTRL +1-Turns on Select mode.

e CTRL + 2 - Turns on Walk mode.

e CTRL + 3 - Turns on Look Around mode.

e CTRL +7 - Turns on Orbit mode.

e CTRL + A - Displays the Append dialog box.

e CTRL + D - Toggles Collision mode.

e CTRL + F - Displays the Quick Find dialog box

e CTRL +H - Toggles Hidden mode for selected items.
e CTRL + F2 - Launch Clash Detective

See the below link for more shortcuts.

http://beyonddesign.typepad.com/posts/2012/05/keyboard-shortcuts-for-autodesk-navisworks.html

6.2 Speed Walking
Holding Shift while using the ‘Walk’

navigation increases linear speed by 2x. The .
. . amera
speed will return to normal when the Shift X ¥ z
; I =

key is released. | postonc: [EEEH| w7z mao

Linear speed in viewpoints can be altered by At K Gl 05| IAT0R F55

right clicking a viewpoint in the saved Vertical Field OF View (9: .30

viewpoints wmdoyv or t.he baf:kgrounq ofa T [ 73.29

model and selecting Viewpoint > Edit 5

. . Rall (=3 | 8.

Current Viewpoint ‘ —
Vertical Offset (3&): 0.00
Horizontal Offset (3&): 566
Lens Squeeze Ratio: 166 —
Motion )
Linear Speed (m/sec): 442

. . . . Angular Speed (*fsec): 45.00

TIP: If you find that your linear speed setting is

defaulting to VERY fast pace it is usually e Colision

because you will have geometry that if very far =

away from the building. A glitch in Navis; this

can be resolved using the above method. Lok J[ comced [[ rep |
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6.3 Sectioning

Introduction to Project Reviews Using Navisworks

Navisworks provides the ability to create cross sections of a model in a 3D workspace.

Cross sections create a ‘cut view’ which provides visibility of the interior of a model. These cut views can

be saved as viewpoints (as discussed in section 3.2).

To access sectioning tools select Viewpoint Tab>» Enable Sectioning @U the sectioning tools ribbon will

then appear.

A=

Viewpoint i Render  BIM 360 Add-ins o -

@ 4 pan

@, Zoom Window +
Steering
Wheels ~ 2> Orbit -

Home iConstruct 2014

103.00 =

@ Look Around = ﬁ
0 Walk -

I8 &

sve (1] I b)| Perspective
Viewpeint

e

iO hsaved Vienpont™

G Align Camera +
Reallsm

. Show Tilt Bar
Camera «

Save, Load & Playback Navigate ~

There are two sectioning modes, Planes and Box.

‘Autodesk Navisworks Manage 2014 CST-IMT-00-XK-CR-Z-00001. rwd

& (J l@_‘

Lighting ~ Mode

Render Style 1

‘ Sectid Enable Sectioning

Enables cross-sectioning of the current

PIaneSC@ allow up to six sectional cuts which allow visibility of the inside of a model without hiding items.

Box mode creates a view of a specific, limited area of a model. As the box is moved, the section will

only show the content defined by the parameters of the box.

Adjusting Sections:

By setting the alignment of the plane to one of the provided presets, the user can utilise the transform
panel to adjust sections manually with the move, rotate and scale tools.

%

Enable
Sectioning

Mowve | Rotate Scals Fit | Save
‘ Selection | Viewpoint

@ Bottom
@ Front
Back
@ Left

([ right

& align To view

Transform =

Enable

2a4] LA

ﬂﬂ Align To Surface
ﬂ- Align To Line

Align to Surface
Aligns the current section plane to the selected surface.

Press F1 for more help

Enable Sectioning

Turn on a Plane

Select one of the presets, or
Align to a surface

Use the transform tool to
adjust the depth of the cutting plane

orwNe

The sectioning tool in Navisworks is a daunting tool to get to grips with at first but once you get used to it,

it can be extremely powerful when used with saved viewpoints.

TIP: To remove the transform axes from your view, click the move tool to deselect it.
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6.4 Split Windows

A simple but hardly used piece of functionality within Navisworks is the split windows option. The Navis
interface does not have to be a single 3D view on a project, it is sometimes beneficial to visualise several
viewpoints. In the below example, columns have been selected from several viewpoints, allowing us the
opportunity to evaluate change in a more informed manner.

Autodesk Navisworks Manage 2014 CST-IMT-00-X

Output Render BIM 360 iConstruct 2014

T R (Fl F
s Lt [5 CST-PLP-00-XX-M3-A-0000L. -

Add-ins r o

I5 Background L_|
|:|

@ Load Workspace ~

i | Window Size :
View | HUD ReferenceJ Show Mode ﬂﬁ Site ~/| Full Windows LF‘ Save Work
Cube| 7 Views | Grid M Scree =1 Show Title Bars * ] SEVE NVDIREpace

Mavigation Aids Grids & Levels §

Scene View Workspace

6.5 Spacebar selection

By Holding down the spacebar with the selection tool highlighted (Ctrl+1) users can select with a window.
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6.6 Compare Models

What would you say if | told you there was a tool available that would highlight all the changes that have
occurred between versions of a model?

A relatively unknown piece of functionality within Navisworks it is the model compare tool, it is used
because the initial results it displays are confusing and daunting for the novice user but with some careful
sectioning and hiding the results that can be produced are very useful indeed.

Step 1: Hold Shift and select both models | e & %
to compare.

Standard %

+]E)]140922_CST-IMT-00-XX-CR-Z-00001.nwd
41022_CST-IMT-00-XX-CR-Z-00001.nwd

Step 2: Click the compare button in the "= — . =
. %=y ! = Eﬁ Appearance Profiler g
Tools section of the home tab. = A=)
g Batch Utility

Autodesk  Animator Script DataTools

Rendering ™

Teools

Step 3: Select the properties you wish to
compare, be mindful that the more you

Find Differences In Results .
select the more changes will be returned.

[C]Type
[ Unigue Ids
D MName

[ Properties

[Irath

A as selection sets.
|+#] Highlight Results
" |Tree

[V]save as Selection Sets I

[ Save each difference as Set

" | Remove old results

7 vide Matches Step 4: Ensure you select to save the results

[ overridden Material
D Overridden Transform

[ ok

TIP: When publishing your NWD files make sure you tick the ‘may be resaved’ box, otherwise the model
compare functionality will not work.
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After selecting ok, The compare process will run and generate selection sets for the changes in the
model. Using some hiding, colour overriding and sectioning we can now highlight the changes that have
occurred between model issues.

Red for change, cyan for addition

TIP: The day you receive models from the suppliers, produce a quick model compare and send out an
NWD for their benefit.
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6.7 Hidden Elements

It is not always possible to work with teams using Autodesk software, which usually interfaces cleanly with
Navisworks. When working on projects with Bentley, ArchiCAD, PDMS or other software, it Is a frequent
occurrence to receive useless line work with the model files.

Obviously, the best way to manage this is to use search sets to ‘Hide’ this geometry in views but it can
also be beneficial to save these sets in a Hidden Elements folder. By clicking the folder you can now Hide
and Unhide (if you wish) all of this geometry in one action.

ISets
[ 8% B3 304 ¥

[_:_1 Hidden Elements

>D Arch
#D Struc

6.8 Missing Attributes Tip

There is a known bug within Navisworks that will not allow all attributes to be visible if the bottom of the
selection tree items are highlighted. If you can'’t see the attributes you are looking for try moving up the
tree and you may be surprised.

S ee popettes
|Standard *) [ ttem | Revit Material | Autodesk Material | Element 1D | TimeLiner | Material
E:g m?ﬁﬂ; = Property Walue

@2 HL_Generic Wall Mounted Circular Lumin Name 400 Digmeter
@22 400 Diameter Type Lighting Fidures
5 i ounted Gircular 1 Icon Composite Object
B Y=Te06 Diametel] Hidden No
— &l Gircular Luminaire Diffuser Required No
" (3 Gircular Luminaire Base Material Circular Luminaire Base
|~ 2 HL_Generic Wall Mounted Gircular | Source File CST-HLE-D0-0¢-M3-M-D0001 rvt
1 2 HL_Generic Wall Mounted Circular | Layer LEVEL 12
%2 Pipe Accessories
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6.9 Right click options
Right clicking the background of a model brings up a wealth of functionality. If you get lost in the

Navisworks interface, try right clicking to find the tool you need.

Scene

Undo Current View  Ctrl+Z Look From L
Set Vi int U 3
Reset All 3 SR
Rendering 3
Select 3
Lighting 3
View All Ctrl+Home Display »
Focus Mavigation Mode 3
Background... Mavigation Tools 3
Global Options... F12 Animation » | v Enable current plane
e Full Screen F11 Align To View
] - Top
Edit Current Viewpaoint...
Bottom
Front
Back
Left
Right
Align To Line

v Align To Surface

Set Box Size

6.10 Working with Native Revit Files

The author does not advise appending native Revit files. Just because Navisworks has this capability
does not make it a good idea. More often than not there are issues with worksets being turned off or
items being placed on a workset that is not visible on all views.

It is preferable to have users set up a view within Revit for the Navisworks export of an NWC file. At the
very least it forces them to undertake a visual check before issuing.

Some contractors have even went as far as asking users to export an NWC then open the NWC in Navis
and save as an NWD to ensure the export works correctly. Maybe a little overkill in my opinion.
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6.11 Using Third Person for Space Checking
A very quick check for space requirements is to use the Third Person Avatar for space checking. Firstly
turn on the third person Viewpoint > Realism > Third person or click Ctrl-T.

Edit the viewpoint

PObdPE

Select the collision settings
Change the height and radius settings to suit your checks
To formalise this process you could change the avatar, for example, when the space

requirements are not met the avatar could change to red.

Note: In the example to the right the height is under 1.8m so the avatar changes to a crouching

construction worker

Edit Viewpoint - View [ 52
Camera
1 X Y z [¥] Calision
L_J_] Gravity
Position {mj): Bi05.52 Jf 181799.54) 04.98 [¥] Auto Crouch
Viewer
Look At {): 5281135 181786, 22.35 Radius (m)
Height (m]
Vertical Field OFf View (%): 66.74 aht (m)
Eye Offset (m)
- i 94.67
Horizontal Field OF View (=): e
0.00 [¥|Enable
@ Auto Zoom
Vertical Offset (%): 0.00 Avatar Construction Work * 4
Angle (°]
Horizontal Offset (%e): 0.00 o= (9 -0
Distance (m) 2,00
Lens Sgueeze Ratio: 1.00
Mo [ Defaus | oK ] l Cancel I
Linear Speed {m/fsec): 442
Angular Speed (®/sec): 45.00
Saved Attributes Collision ?
[¥] Hide/Required
Settings...
[7] Override Material
| p— /
oK J I Cancel I l Help
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6.12 Presentation Level Graphics

Navisworks is a functional tool not a photorealistic renderer (the rendering tools are getting better).
Sometimes you just want a tidy view, you don’t need a render. There are some settings you can change
to improve the aesthetics of your view. Application menu > Options > Display

" Optians Editor
General [ ooeme
Interface
ey s e | = Gene:l Autodesk Effects
Selection - (- Interface . K
:aawa Levelof Detal [Medum < . Display Urits Screen Space Ambient Ocdusion
napping i
Viewpoint Defad| | Detel Selection Shader Style
irie Guaiee e e B imited ligh
L ;: E;’vopemes e - Snapping Use Unlimited lights
Autodesk. Viewpaint Defaults
-~ Drivers Graphics System ' | - Links Autodesk Materials |
Appending and | Harduare Acceleration 4 y
Devek - Quick Properties 7
poi WRF Harduare Acceleration I £)- Display et
- F
e S _tm., | e 2 Use Lod Texture
Viewcube CPU Occlusion Culing Drivers Reflection Enabled
@PU Ocdlusion Culing ‘Appending and Merging
e = ek Hichight Enabled
FicResds 2 Heey ;
Tools xrzaves £ l -~ Grids Bump Enabled
shon positon ] alosmn.amn Image Library |BaseResolution  ~
Show G Lot N.aulgahon Bar _
Show RapidRT Status. -~ ViewCube Max Texture Dimension
Steeringiheels
FontSze 10
- User Interface Procedural Texture Size (512 +
primitives (- Model
Point size ] (i File Readers Multi Sample Anti Aliasing
[#-Tools
Line size
v MSAA Level [4x =
. & -]
Enable Parametric Primitives

Transparency

Interactive Transparency

o) (o | ) | [ [ Eporte, ] [ mpors., ok J[ conel [ e |

Examples of Standard Settings against new settings. It is not to everyone’s taste and | must admit | leave
it on the standard settings 90% of the time but when | need images from presentations or reports, this
quality is usually good enough.

Credit for tip: http://beyonddesign.typepad.com/posts/2012/12/tip-autodesk-graphics-in-navisworks.html
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Thanks for reading, | hope you enjoy the class. Feel free to get in touch.

Michael

Michael.Boyd@WSPGroup.com

@_michaelboyd

uk.linkedin.com/in/michaelwboyd/
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